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Update! Update! Update!
No. This doesn’t mean a news flash. Instead, this is a notsogentle reminder for
everyone to run updates on their system. By now, I’m sure that many of you
realize that there are new Live CD releases of most of the different “flavors” of
PCLinuxOS, coming with your choice of your favorite desktop environment, all
set up and ready to go. Of course, if you’ve kept your installation updated
regularly, you already have the “latest and greatest” of
PCLinuxOS, and you won’t have to reinstall. The thing
about a rolling release is that the user has to take
responsibility and update their system periodically.
Without those regular updates, it’s nearly impossible to
provide a stable upgrade path. After a while, many
things may have changed, been updated, or been
upgraded. It’s not even reasonable to expect that an
upgrade path exists when you haven’t applied the
previous three (or 20) upgrades. If you’ve not been in
the habit of regularly updating your system, it might be a
good time to consider reinstalling. Fortunately, a
reinstallation of PCLinuxOS on today’s modern
computers with multiple processor cores usually takes
less than 30 minutes.
So how often should you apply updates? Without a
doubt, there are some PCLinuxOS users who apply
updates to their system daily. They feel that it keeps
their system in tiptop shape, and it keeps them on the
front edge of what’s happening with PCLinuxOS.
Reasonably though, you probably should apply updates
either weekly or biweekly. That should be frequent
enough to keep your system in excellent shape and
condition. While every two weeks should be the
absolute maximum amount of time to elapse between
updates, there are folks at the other end of the spectrum
who only update their systems once a month. However,
updating only once a month increases the chances of

forgetting to apply updates during one month, which means that the next month,
when (if?) you remember, you now have two months of updates to apply – which
greatly increases the chance of something borking your installation.
I usually recommend, especially to new users, that they pick a day of the week
(associating it with their favorite TV show usually works well) and that they
should run updates on that day, every week. So, when they see a NEW episode

of Law & Order come on (presuming they are a Law &
Order fan), they should also think about keeping their
PCLinuxOS installation in “good order.” Then, if they
forget one week (or Law & Order gets preempted by
some other inane “special” broadcast), they can do it
the next week, and no more than two weeks has gone
by between updates.
I’m also sure most folks have heard that Texstar has,
on the advice of his doctors, stepped back from the
intense daytoday work on PCLinuxOS. For many
months, Texstar had thrown himself into packaging a
separate 64 bit PCLinuxOS repository (all the
applications  more than 12,000 of them  have to be
rebuilt for a 64 bit version). Over that time, he ran out
of “gogo” juice, to use his words. Neal has taken over
the packaging and development reigns, while Old
Polack is giving the forum and PCLinuxOS web site his
evervigilant eye and care. Texstar hasn’t gone away.
He is still lurking about (he’s even still posting
periodically in the forum), keeping a watchful eye on
the proceedings, but from a more distant vantage
point. With Neal and OldPolack tending to
PCLinuxOS, Texstar’s baby (PCLinuxOS) is in safe,
responsible and good hands.
That’s about it for this time around the bend. Until next
month, I wish each of you peace, serenity, happiness
and prosperity.

Welcome From The Chief EditorWelcome From The Chief Editor
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by Meemaw

We’ve seen Shutter before. Some of us use it as a
simple photo editing program, and it works very well.
We even covered it in the Photo Viewer series in this
magazine earlier in the year.
Did you know that it also takes screenshots?
When you open Shutter, you get the main window:

The tab that’s there already is the Session tab. As
you open images or take screenshots, a thumbnail
of each will appear on the Session tab. The tools
are, left to right: Redo last screenshot, Selection
Tool, Desktop screenshot, Window screenshot,

Selection screenshot, Menu screenshot, Tooltip
capture, Website capture, Edit and Upload. At the
bottom, you will see dimensions and file size of any
screenshot you have taken or image you have
opened, and two extra choices for your screenshot:
whether or not to include the cursor, and the number
of seconds to delay before your screenshot is taken.
Although not visible by default, there is also a
navigation toolbar you can activate at the bottom.
The tools from left to right are sort descending (this
sorts the group of shots in the Session tab by file
name from Z to A), previous shot, view Session tab,
next shot and sort ascending.

When you are ready to take a screenshot, you have
several choices. Using the window tool, you can
take a screenshot of any of
your desktops (Shutter calls
them workspaces) or all of
them in order. If you do all of
them, Shutter will save all
the shots in one file. This is
a screenshot of my four
laptop workspaces.
Your second choice is to
take a screenshot of any
window you have open. If
you are trying for a specific
window, the drop down
arrow next to the window
tool will list the windows you
have open so you can
choose the one you want.

That way you won’t have to crop a screenshot down
to just one window. This is how I have taken most of
my screenies for magazine articles.

Gnome 2.32: Shutter Shoots ScreeniesGnome 2.32: Shutter Shoots Screenies
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Your next choice is to capture a section of a
window.... I honestly haven’t figured this out, since I
can’t seem to take a screenie of anything but a
single window with it. If I drag my cursor across it,
then press Enter or click with my mouse, I don’t get
the section of the window that I seemingly outlined,
but the whole window. If you want to take a screenie
of your panel instead of your whole desktop, it works
fine.
You can also capture a drop down menu, tooltip or a
website shot from Shutter using the next 3 buttons.
Make sure you have set a delay for the drop down or
tooltip to give yourself time to access them.
I covered Shutter in the photo editing series I did last
year. The colored icon at the right side of the main
Shutter screen is the editing tool. It will open your
active shot in a larger window, and you can crop or
edit it there This is very handy if you have taken a
screenie, but decide you want a smaller area than
what you shot, or want to add something to the
screenie (text, lines, geometric figures or an
indicator of some sort).

Gnome 2.32: Shutter Shoots Screenies

Screenshot ShowcaseScreenshot Showcase

Posted by weirdwolf, February 3, 2012, running LXDE.

http://www.enkiconsulting.net
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by Paul Arnote (parnote)

February 23, 2012. It was early morning, and still
dark outside. I was sitting down at my computer,
preparing to lay out the March issue of The
PCLinuxOS Magazine. As always, my first task is to
check my email. I subscribe to the TechRepublic
blogs, and one item caught my attention in their
“Windows Desktop” email. The headline read “Add
Google Docs to the Windows 7 New menu,” and the
article went on to talk about how, with a simple
Windows Registry hack, you could add a quick
access menu item to the Windows menu to access
your Google Docs account.
Now I know that many computer users today shun
using Google products, due to privacy concerns. But
this magazine uses Google Docs as the primary
vehicle to share magazine articles for editing among
the magazine staff. Quite simply, there’s not much
else out there that works for distancebased
document collaboration and editing, at least that I’ve
found. Plus, if Google wants to spy on The
PCLinuxOS Magazine to see what we are up to, I
say go ahead. I’m all for anything that gives
PCLinuxOS more exposure and publicity. We have
nothing to hide, even from the prying eyes of
Google.
It – the TechRepublic headline and story lead – got
me thinking about how easy it would be to create
something similar in PCLinuxOS. I run the latest
version of Phoenix, the PCLinuxOS version of the
Xfce desktop, on my desktop computer. You might
(or might not) be surprised at how easy it is to do

under PCLinuxOS. The entire process is made
simple by one little command: xdgopen.
Using the xdgopen command, I was able to create
a custom launcher on my Xfce panel that, when
clicked, opens Google Docs in my default web
browser. The xdgopen command is a powerful little
command that can save you a lot of trouble.
Basically, xdgopen takes a file name – or a qualified
Internet URI – and opens the file using the default
application that is associated with that type of file.
We’ll talk more about this in a bit. First, here’s how I
created my launcher for Google Docs on my top
Xfce panel. The process is similar in other desktop
environments, such as LXDE or e17. However, since
I am using Xfce on this particular computer, the
instructions below will be somewhat specific to Xfce.
It won’t (shouldn’t) differ significantly under other
DEs, however.

Step 1: Add the launcher to the panel
Under Xfce, right click on the panel you want to add
the launcher to, and select Panel > Add New Items...
from the context menu that pops up.
Select “Launcher” at the top of the list, and select
the “Add” button at the bottom of the window.
Another window will open asking you to select which
panel you want to add the launcher to. Panel 0 is the
top panel, and Panel 1 is the bottom panel. After
selecting which panel to add your new launcher to,
click on the “Add” button in the second window.

This will add your launcher to the selected panel.
Under Xfce 4.8.x, the launcher is added at the far
right edge of the selected panel. Right click on the
launcher, and select “Move” from the context menu.
Then, just drag the launcher to the location you want
it to appear at on your panel.

xdg-open: Making Life Easierxdg-open: Making Life Easier
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Step 2: Pick an application, any application
Next, you will want to right click on the new launcher,
and select “Properties.” Below is how the
“Properties” dialog box looks for your new launcher,
before you’ve selected the properties for your new
launcher.

Along the right side of the Launcher dialog box, you
will see six buttons arranged in a vertical row. Select
the third one, to add a new application to the
Launcher list. You will see a new dialog box appear,
with all of the installed applications on your system.

Literally, just pick an application – any application.
We’re going to change it anyway. Once you’ve
clicked on one of the applications in the list, click on
the nowactivated “Add” button. I selected Firefox
from the list, and below is how my Launcher
“Properties” box looks after adding Firefox. I could
have picked any other application from the list,
however.

Step 3: Edit the launcher
Now, remember that we are creating a launcher
specifically to open Google Docs. Since Google

Docs isn’t in our list of installed applications, we will
want to edit the entry in the Launcher Properties
dialog box. This is why I said pick an application –
any application – from the list of installed
applications. Click on the sixth (and last) button in
the vertical row of buttons on the right. This will open
a dialog box where you can edit the properties of
your new launcher.

Make the following edits to your launcher:

xdgopen: Making Life Easier
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Name: Google Docs
Comment: Create/share documents online
Command: xdgopen http://docs.google.com
Working Directory: /Documents (optional)
Next, click on the icon displayed in the middle of the
dialog box. For me, that is the Firefox icon. Select a
new icon for your Google Docs launcher.
From the drop down list at the very top of the
window, choose “All Icons” so you can see all the
installed icons on your computer. Find the icon you
want to use (I chose the “googlechrome” icon, since
it’s easily recognizable as a Google product), click

on it, and select OK at the lower right corner of the
dialog box.

After all of your edits, your dialog box should look
something like the one on the right.
Click on the “Save” button at the lower right corner
to finalize your new launcher. Now, whenever you
click on that icon on your panel, Google Docs will
open in your default web browser – whatever that
happens to be. For what it’s worth, that default (for
me) happens to be Firefox.

A little more about xdgopen
You can use xdgopen for more than just
automagically launching your favorite web sites in
your default web browser. Xdgopen uses file type
associations to open files in the associated default
application.

For example, typing xdgopen ~/Documents/old
settlerbeans.pdf on the command line will cause the
specified PDF file to open in your default PDF
viewer. Typing xdgopen ~/Documents/myresume
2011.doc will cause the specified document file to
open in your default word processing application.
Typing xdgopen ~/Documents/mylist.txt will cause
the specified text file to open in your default text
editor. Typing xdgopen ~/Pictures/AuntSuzie.jpg will
cause Aunt Suzie’s picture to open in the default
application associated with JPG file. I’m sure you get
the idea here.

xdgopen: Making Life Easier
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Being a command line utility, xdgopen doesn’t deal
very well with spaces in file names, which, although
allowed, shouldn’t be used in Linux file names for
this very reason. However, there are many users
who do include spaces in file names, and dealing
with those files is actually quite easy. Let’s suppose
that, in one of the previous examples, your text file
was named “my list.txt,” instead of “mylist.txt.” If you
try to type xdgopen ~/Documents/my list.txt, xdg
open will fail and exit with an error, due to the space.
However, if I type xdgopen ~/Documents/”my
list.txt” and place the offending file name with
spaces in it in quotes, all will be well and xdgopen
will open the file in your default text editor.

Summary
As you can see, the xdgopen command can be a
very powerful little tool. If you have a document file
you frequently refer to, xdgopen makes it very easy
to access that file with only one click of your mouse.
If you have a web site you frequent, xdgopen
provides access to that web site with only one click
of your mouse.
Who needs a registry hack? We don’t need no
stinking registry hacks. It makes me proud to be a
Linux user.

Screenshot ShowcaseScreenshot Showcase
LinPC.us

Posted by Meemaw, February 15, 2012, running Xfce.

xdgopen: Making Life Easier

http://www.linuxfoundation.org/
http://www.ibiblio.org
http://www.linpc.us
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MP3 OGG

ms_meme's Nook: Linux Trailms_meme's Nook: Linux Trail

MP3 OGG

I was booting that old Windows
And moving just like a snail
When I rode to the PCLOS Forum
Along the Linux Trail I downloaded a new ISO

Users said it would never fail
Now the Sandbox is my bunkhouse
Along the Linux Trail

I love to lie and listen to the stories
And hang out with Tux at the bar
Hear those legends and epic tales
About our hero Texstar

What do you know his fame is spreading
PCLOS will always prevail
Time for you to join our forum
And ride the Linux Trail

Time for you to download that ISO
And ride the Linux Trail

http://pclosmag.com/html/Issues/201203/files/alongthelinuxtrail.mp3
http://pclosmag.com/html/Issues/201203/files/alongthelinuxtrail.ogg
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Answers on Page 35.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

When I first started using graphics
applications, I was simply amazed by
the “oneclick” effects that came preinstalled.
Need a border on the image? Click. Want a
texture on the image? Click. Want a lighting
effect? Click. And the program would do the
rest. Well, the same is true of the Gimp. I've
talked aobut some of the available filter effects
before, but it's worth pointing out a few
favorites that you simply might miss. These
are easy to overlook because so much is
packed into Gimp! I recently stumbled on the
“Old Photo” filter. It's located at

Mark's Quick Gimp Tip
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Filters>Decor>Old Photo. When selected for
a photo/image, a dialog comes up allowing
you to make a few changes (if you wish).
Simply click “OK” and the filer does the rest.
At right is a before and after of my comic strip
George. As you can see, the Old Photo filter
gives my comic strip the look of having been
found in an old newspaper from 50 years ago.
So, when editing a photo in Gimp, slow down
and give each of the filters a look and a test
run. You'll be surprised how many there are
and how they can enhance the image you're
editing.

Find at least seven differences between cartoons.©2
011
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Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.georgetoon.com/blog/cartoonist-day?comic-book-day/
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by Darrel Johnston (djohnston)

How did you became Neal's successor as the
maintainer of LXDE?
I got a request from Neal. He said that my
knowledge of LXDE made me the most logical
choice. In Neal's words: “Beyond those things, I trust
you with 'my baby,' PCLinuxOSLXDE.“ I asked him,
“How do I create an ISO?“, and he taught me.

What is it about LXDE that attracts you?
LXDE is simple and lightweight. It works well with
any programs that I can install. You often need to
use a text editor to configure the LXDEDesktop.
Looking ahead, and thinking about how many more
people will be using it, more applications will be
written especially for LXDE.

What tools have you written for use with LXDE?
As an extra tool for LXDE, and from an idea by
parnote, I wrote LXautostart. All other programs or
tools were written as a result of suggestions, or
because I wanted to write it. Sleeptimer was written
because of an issue from pclxd3os on the
PCLinuxOS forum, and I was asked what would be
needed to write it.
This was my thinking:
a little question...
What is needed for an automic shutdown program?
Maybe two scripts...
First script, for shutdown
#!/bin/bashdbussend system printreply–dest="org.freedesktop.Hal"/org/freedesktop/Hal/devices/computerorg.freedesktop.Hal.Device.SystemPowerManagement.Shutdown

Second script
A script where the number of minutes to wait before
shutting down the computer can be entered ...
When it's needed, I can create a little app for that...
The latest creations, (LXtemp, LXuptime, XSearch),
were suggestions from Neal. Screenie was written
by Neal, and I added some things. LXTemp was a
group effort in cooperation with Neal, ghostbunny,
and me. Ghostbunny had written most of the code.
One evening I was watching a DVD on my laptop,
and it switched to a black screen with the monitor
offline. That was when I started looking at how to
stop the computer from turning off the monitor. In
our repo is Caffeine, a good application, but it needs
a lot of resources. So I wrote LXdpms.

What other packages have you contributed to
PCLinuxOS?
I don't know. If an update is available for a package
in the repository, I try to package it. I keep a close
eye on mediainfo and dvdstyler, but I try to do other
packages, too. When I have problems, I ask the
maintainer, or our other packagers. And we find a
solution.

What motivated you to become a packager for
PCLinuxOS?
My first, ahhh, second script was systeminfo, and I
was thinking this is exactly what is needed for us

Leiche Becomes New LXDE MaintainerLeiche Becomes New LXDE MaintainerMarching On...Marching On...
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noobs. I asked maik3531 for help, and he taught me
how to build my first package. Thank you, maik3531.
My first script was saa713x, and it was designed to

capture video from my tv card. My mentor on this
was flux. He helped me with my first steps in shell
scripting. Thank you, flux.

You indicated that you issued another ISO
because it had been three months since the last
one? Do you intend to stick to a three month
schedule?
Yes, that's right. Our latest LXDE ISO is 2012.01,
and before that it was 2011.09. Whether or not I can
create a new ISO every three months, I cannot say.
If it is needed, I will create a new ISO.

Out of all of the desktop environments available,
what role do you see LXDE fulfilling?
Fulfilling? I like it simple, and LXDE is simple and
lightweight.

Do you have any plans for more special
additions to LXDE?
I don't know, let's see what the future brings. If
something is needed, I will add it.

What is your given name?
Daniel MeißWilhelm. Of course, I go by Leiche on
the forum.

On holiday in Denmark. Advertisement

Marching On... Leiche Becomes New LXDE Maintainer

http://pclinuxos.com/?page_id=184
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What is your profession?
Since 01 August 1992 I have been working for the
MAN company in a truck workshop. My main area is
electrical systems.

Are you married?
Yes, I am. Over 10 years now. We have two
children, a girl, and a boy. And we have a cat.

What do you like to do to have fun or just relax?
In the summer, I like to ride my bike. I like to
experiment with some scripts, and read topics in our
forum. In the winter, I just relax and watch TV, or
listen to music. I know I should be more active in
sports, but I lack motivation.

Do you still play in the Die Kellerleichen band?
No, Kellerleichen band is really dead.

Is there anything else you'd like to share?
What else can I share? What I have created is in our
repositories. Music  see my last answer. We all can
help to move PCLinuxOS forward. This is the beauty
of a community that cares.

Left: Playing miniature golf.

The NEW
PCLinuxOS
Magazine

Created with
Scribus 1.3.9

Marching On... Leiche Becomes New LXDE Maintainer

http://www.scribus.net
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by Paul Arnote (parnote)
As you might imagine, since Gnome is one of the
two most popular desktop environments for Linux,
there are a lot of applications that allow you to tailor
Gnome to better reflect how you work with it. The
ability to customize your Gnome menu is no
exception.

Stock Gnome Menu
Before I go showing you custom Gnome menu
configuration applications, we should first briefly
review the layout of the stock Gnome menu. As I
previously pointed out when we started the series on
Gnome 2.32, a “freshoutofthebox” PCLinuxOS
Zen Mini installation does not use the typical Gnome
menu and panel layout. In fact, one of the first things
I did after installing Zen was to return Gnome 2.32 to

its more usual appearance with two panels and the
usual Gnome menu items.
Under the “Applications” entry of the stock Gnome
menu, you will find all of your installed applications
neatly arranged into the standard menu structure
used for PCLinuxOS.
The “Places” menu gives you quick access to a
selection of common folders in your home directory.
If you want a folder to show up in the places menu,
simply drag the folder from the right pane in Nautilus
to the lower left pane.
The “System” menu holds the menu entries for
governing Gnome’s preferences, tools for
administrative tasks, the Gnome Control Center,
plus the Gnome about box and options to lock your
screen from prying eyes, logging out the current
user, or shutting down your session or computer.

Alacarte

Alacarte is the Gnome menu editor. You can launch
it from a terminal session by typing alacarte & on the
command line, or by selecting the “Main Menu”
application from Applications > More Applications >
Configuration menu entry.

Taking a look at the Alacarte window, it is quickly
apparent how easy it is to use. Simply click on a
menu item’s check box, checking or clearing the
check next to it.
In case you can’t fathom why you might want to edit
the Gnome menu, let me provide a possible
scenario for you. Say you are setting up a computer
that will be used by multiple users. As the
administrator, you can go in and remove menuThe stock Gnome menu

Gnome's Alacarte menu editor.

Gnome 2.32: Customize Your MenuGnome 2.32: Customize Your Menu
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entries in the Applications menu that you may want
to limit access to. Alternatively, you can use Alacarte
to “clean up” the Application menu of items you
rarely or never use. In either case, the application is
still installed and can be accessed by a
knowledgeable user from the command line, but the
menu entry can be toggled on or off to suit individual
tastes and needs.
Because Alacarte doesn’t pull in a lot of Gnome
specific dependencies, it is also used as the defacto
menu editor for Xfce – at the moment. It can also be
used to help manage the menu entries in other Linux
desktop environments, like LXDE.

AGM: Advanced Gnome Menu
The Advanced Gnome Menu is a panel plugin
written in Gtk+ and Python that is supposed to allow
users to create their own custom menu, filled with
their most commonly used applications.
Unfortunately, Advanced Gnome Menu hasn’t seen
active development since 2009, and the web site
where you could download all the AGM plug ins is
now defunct. While the source code is still available
on the opendesktop.org web site (good for anyone
who may wish to pick up the development reigns on
this), AGM is of very little use without the plug ins.
Also, since Gnome has moved on to the radically
different 3.x version, it’s doubtful that anyone is likely
to resume active development on this promising plug
in.

Mint Menu
Named after the Linux distro where it originated, the
Mint Menu provides a neat, modern and organized
appearance to the traditional Gnome menu that is
very easy on the eyes.
Initially, Mint Menu opens to a screen displaying
your favorite applications on the right twothirds of

the screen, while Places and System entries appear
in the left onethird of the screen.

Selecting the “All applications” button in the upper
right corner of the initial view brings up the view,
shown above, that shows all of the application menu
entries. They are either all shown, (as in the image
below), or you can choose to view each subsection

Mint Menu main appearance.

Mint Menu viewing all applications.

AGM: Advanced Gnome Menu.

Gnome 2.32: Customize Your Menu
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of the Gnome application menu to view the
applications by sections.

Mint Menu also exhibits some flexibility regarding
how it runs. It can run as a standalone application in
a window on your desktop (like above), or you can
run it as a panel plug in, which is the most likely way
to use Mint Menu.

Summary
As you can see, Gnome provides several utilities to
allow you to customize your Gnome menus. While
Gnome has been often criticized for deliberately
hiding configuration settings from their end users, it
has also opened up the possibilities for additional
apps to be written that fit well into the Linux way of
doing things: apps that do one thing, and do it well.

Screenshot ShowcaseScreenshot Showcase

Visit.
Contribute.

Build.
The PCLinuxOS
Knowledge Base

It Belongs To YOU! Posted by cstrike77, February 7, 2012, running LXDE.

Gnome 2.32: Customize Your Menu

http://pclinuxoshelp.com/index.php/Main_Page
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Forum Foibles: PCLOS Howdy!Forum Foibles: PCLOS Howdy!

Howdy fellow Texan!
Texstar

Howdy Yaw!
Seriosly, a big hello from South
Texas. A big handshake to all.

Reboant

.howdy.howdy.howdy
thx again for the texas sized welcome,
everyone. much appreciated.

jtb2

Howdy!
Hi, I'm not from the wild west as my
subject line might have you to believe,
actually from Canada. I'm really happy
with PCLOS, but I am a bit new still. I
love how either everything works or it
is usually easy to fix, and it looks
snazzy. I also love all the support, this
forum is awesome! Now this isn't a
testimonial, I'd just like you guys to
know where I stand. Great to be a part
of something as Awesome as PCLOS.

aldendino

Howdy all. Jeddaboy
Howdy gang! coffeetime
Howdy Folks. johnnie.nucleo

Howdy Tex!
Aint talked to you in a while!

Codenomics

Howdy,
just making sure I track this thread..

Thanks!! Linuxera
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Howdy All Jeff91

Howdy gang! coffeetime

Forum Foibles: PCLOS Howdy!

Howdy!
Once my favorite OS, I drifted and
I'll confess. Once more, I managed
to shoot myself in my foot.

Alfanut
Howdy!

Hello all. I am new to PCLinuxOS.
I have been watching on and off
for about a year and glad to see it
is still going strong.

CharlieB

Howdy, all! pags
Howdy AndrzejL
Howdy All Jeff91
Howdy all. abstract
Howdy, folks! Xavier
Howdy! hammerhead

Howdy
to the PCLinuxOS gang!

Chisum

Howdy
Need a little assistance,
believe I came to the rightspot.

Tactics

Howdy.
LiveUSB is on my horizon.

nightcap
Allo Allo and Howdy

GOTHBITES
Anyways, howdy to all!

MarkNC!

Howdy from rural MD, USA
bosko
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by Darrel Johnston (djohnston)

Firefox 10 is not exactly new. It is an upgrade from
version 9. The Firefox web browser is known for its
flexibility, due to the use of addons. Addons add new
functions or features not available in the default
program. Addons may also enchance some features
contained in the default Firefox web browser.
Mozilla has decided to release a “new” Firefox
version every six weeks. When the new version is
released, the major version number is incremented
by one. This action has the potential to render
addons inoperable if they are not designated as
compatible with the newer release number. It can be
frustrating to see your favorite addon disabled
because the author has not yet supplied an update.
In many cases, the addon is already compatible, but
has not been so designated. In some cases, the
author has simply not issued any updates to their
addon at all.

For addons that are still compatible with the newer
Firefox version, there is a simple edit to a file that will
insure your favorite addon does not get left behind
with the next Firefox major release number. Firefox
addons have an xpi file extension. Normally, you
would install the addon directly from Mozelle's or the

author's website. However, if you wish to keep an
archive of the addon, download the xpi file and save
it to your hard drive instead of directly installing it in
the browser. The xpi files are actually a zip format.
Using fileroller, I can open one whether the
extension is zip or xpi.

Each addon includes a file named install.rdf. This is
the file we will edit. Again, using fileroller, I can
simply double click install.rdf within the fileroller
window to open it in a text editor.

The contents are in XML format. We are only
concerned with one particular section of the
install.rdf file. That section is shown below.
<! Target Application this extension can install into,
with minimum and maximum supported versions. >
<em:targetApplication>
<Description>
<em:id>{ec8030f7c20a464f9b0e
13a3a9e97384}</em:id>
<em:minVersion>8.0</em:minVersion>
<em:maxVersion>20.0</em:maxVersion>
</Description>
</em:targetApplication>
The value after the <em:maxVersion> string is the
only thing we are concerned with. The value
determines what the highest Firefox version number
can be for the addon to be considered compatible.
For some peace of mind, I have set the version
number to 20.0. I can always change this value at a
later date. As long as the addon is still working
properly, I can continue to have it upgraded
automatically with each major Firefox release
number. To install the edited xpi fle to Firefox
initially, first remove it in Firefox’s Tools > Addons
section. Then, rightclick the xpi file and select Open
with Firefox.
The “new” search engine is only new to me. I have
now made it my web browser’s default start page.
The search engine is called, appropriately enough,
Startpage. Startpage was released in 2009 in the
United States as a new name for the Ixquick search
engine. The Ixquick search engine was developed
and launched in 1998 by David Bodnick in New
York. Startpage is owned by a privately held

A New Web Browser & Search EngineA New Web Browser & Search Engine

https://startpage.com/
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corporation, Surfboard Holdings, BV, so it is
completely independent of outside forces that might
seek to exploit user data. Startpage and Ixquick are
not affiliated with any national or international
organization, corporation, commercial enterprise,
government, or intelligence agency. Of course,
Startpage would be obligated to comply with legal
demands for information from proper government
authorities, but because we have no personal
information on file, there would be no data to deliver.
Maybe that's why Startpage and Ixquick have never
been subpoenaed for any user data.

Startpage, and its sister search engine Ixquick, are
the only thirdparty certified search engines in the
world that do not record your IP address or track
your searches. Startpage abolished the use of
Unique ID cookies as of June 6th, 2006. It only uses
one anonymous cookie that is used to remember the
search preferences you saved for your next visit.
The cookie expires after not visiting Startpage for 90
days and is anonymous. A Google cookie called
'PREF' can be set when you use Firefox or Chrome
as your browser, regardless of whether you visit
google.com or any other site. There is a technical
reason why this happens. More information can be
found here. One way to prevent this is to disable or

limit the use of cookies. This is something Startpage
recommends from a privacy perspective. For Firefox,
go to 'Preferences' > 'Privacy', for Chrome, go to
'Options' > 'Under the Hood', and disable the
cookies.
Startpage does not share your personal information
with any third party, including other search engines
and the provider of its sponsored results. The
"Startpage Proxy" extends the great privacy
protections you get from our search engine to cover
your browsing activities, too. Our proxy lets you
browse thirdparty websites safely and
anonymously, without passing on any private,
personally identifiable information. It means you can
now surf the web as anonymously as you can
search with Startpage. The proxy allows you to view
thirdparty web pages loaded through Startpage's
servers. Details on how it works can be found on the
"Startpage Proxy Explained" page.
For the security conscious, these features mean
better privacy for the user. Startpage has an
extensive personal settings page.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

A New Web Browser & Search Engine

http://twitter.com/iluvpclinuxos
http://stackoverflow.com/questions/6301114/how-pref-cookie-google-com-appears-in-firefox
https://startpage.com/proxy/eng/help.html
https://startpage.com/do/preferences.pl?language_ui=english
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by Meemaw

With the new year, I thought I might start using a Linux financial program to keep
track of my budget, so I investigated the programs available. I found nine. Of
those nine, only eight are in our repository, and one of those is a command line
program. Yet another is, in my opinion, useless. So I am down to six. Over the
next few months, I will review these six: HomeBank, iFreeBudget, Money
Manager EX, grisbi, gnucash and kmymoney. All are in the PCLinuxOS
repository.
HomeBank
The home page is http://homebank.free.fr/. It’s also available for Mac & Windows.
The user manual, in English, is at http://homebank.free.fr/help/index.html.
When you start HomeBank, you will be shown an opening dialog window which
says ‘Create a new Wallet’, ‘Open an Existing Wallet’ or ‘Open the Example File’.
You want to create a new wallet. This is the file you will open when you work on
your finances. You will have four windows, two of which are shown below:

The first window asks you to name your wallet, the second one detects your
preferred language in the system (not shown), the third asks you to create an
account. Give your account a meaningful name, and indicate what type of

account it is. The choices are bank, cash, asset, credit card and liability. Put in
your account number, enter your beginning balance, and if you want a reserve
amount in your account at all times, you can enter a number in the ‘Overdrawn
at’ section. The last screen is a confirmation screen. If you wish, you can click the
Back arrow and proofread what you entered before you click OK.
At this point you only have one account in the main screen. Your toolbar will look
like this:

We have New, Open and Save as the first three icons. The next six icons
correspond to the entries in the Manage menu (Accounts, Payees, Categories,
Assigned Transactions, Archives and Budget). The next two are in the
Transactions menu (Show and Add) and the last five are in the Reports menu
(Statistics, Trend Time, Balance, Budget and Car Cost).
To add another account, like a savings or credit card, you would click on the
Manage Accounts button to the right of the save button, or access it from the
Manage menu. The manage accounts screen has the same things that the new
account screen has, plus a few
more. There are check boxes for
‘Include in the Budget’ and ‘This
account was closed’, as well as a
couple of Check Number boxes. In
HomeBank, you can put in your
starting check number here, and
HomeBank will autoenter your
account number when you enter a
check. You will see two of those
entries for a couple who has two
books of checks for the same
account.
I added a savings account. You can
add other accounts as you desire.

Linux Financial Apps: HomeBankLinux Financial Apps: HomeBank

http://homebank.free.fr/
http://homebank.free.fr/help/index.html
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Here is my main HomeBank window now:

You need to go to File > Save As... and give your wallet file
a name. After that, you can just click on ‘Save’ in the
toolbar.
Now we have our accounts set up. Doubleclick the name
of the account you want to view. You will get another
window with that account’s ledger in it (top right).
Notice that your balance is at the top of the window to the
right of the word ‘Today.’
To add your transactions, simply click the Add button.
From here you can add as many transactions as you want.

When you click Add in the lower right corner, your transaction is added to the
register, but this window remains open. In the window, we see all the necessary
information for your register. I should first point out a few things, though.

First, you can add payees as you are filling
in the transaction, and they will be saved.
Also, you need to designate a payment in
the Amount window by clicking the +/
button or the program will add everything
to your balance instead of subtracting the
checks.
Next, you can keep track of the type of
payment you are entering with the
Payment drop down. You can choose
check if you wrote a check, but there is
also Credit Card, Debit Card, Transfer,

Linux Financial Apps: HomeBank
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Electronic Payment, Deposit and a few others. Info actually keeps track of your
check numbers. Back on the register window, info will display the check number
if you wrote a check, plus the type of payment made. There is a place for a
description, in case you wrote a check at a store for something in particular and
want a note of it in your register. The concept of tags has been added as well, to
provide better search results.
The ‘Validated’ check box is checked during your bank statement reconciliation,
and the ‘Remind’ check box can set a reminder for a special transaction, such as
loaning money to someone.
HomeBank includes many preentered categories, but that does not mean you
can’t add some of your own using the Manage Categories window. I noticed that

auto insurance is in the
category Insurance, but I want
it in with the cost of operating
my auto. I clicked on
Automobile and added Auto
Insurance as a subcategory.
Once you have your
transactions entered, there
are a couple of extra things
you can do. Many of our
transactions are payments we
make regularly, like rent, gas,
electric, cable and phone bills.
We can set those up as
automatic transactions which
are added to the appropriate
account on a certain date
every month. This works
particularly well if it is an

automatically withdrawn payment. For example, I have my life insurance
premium electronically withdrawn from my checking account once a month. I
have to remember to enter that into my check register every month. The
automatic payment is an easy way to make sure it isn’t forgotten.

Automatic payments are
configured in the ‘Archive’ dialog
in the Manage menu. When the
window opens, you create an
archive by filling in the details of
your transaction. I have filled in
an automatic life insurance
withdrawal below. Notice that it
is almost like the transactions
list in that you fill in the payee,
category, type of payment and
account, but at the lower right of
the window you must activate
the automation and designate
how often it is to be done and
on what date the soonest one is
to occur.
You can add as few or as many
as you wish. You can also

remove one when it’s no longer needed, such as when the car is paid off. When
you get back to the main window, it will have the automatic payment in the lower
half of the window:

There is a button for Assigned Transactions, but it seems to be one where you
can assign a specific category and payee to a specific description. When you
enter that description into your transaction window, it automatically fills the Payee

Linux Financial Apps: HomeBank
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and Category. There is also a choice in your account window (your check
register), which is called Inherit Transaction. If you inherit a transaction,
HomeBank creates a new one exactly like the one you chose to inherit. Then,
you can change the date and amount of payment and save it as a new
transaction. This can be handy for things like the weekly grocery store visit.
One different thing you can do is a car cost report, which includes mileage. This
particular feature involves editing your auto fuel expenses. Many of us keep track
of our mileage, along with the amount of fuel we put in the vehicle when we filled
it. We can transfer that information into HomeBank’s transaction window in the
following manner.
In the transactions window I entered a debit card transaction for fuel using the
category Automobile. In the Description, I entered the vehicle’s odometer reading
as d=26663 and the amount of fuel purchased as v=18.2. Since I have a starting
odometer reading before this one, the program can now figure the gas mileage

(MPG) as well. Adding car payments, insurance, repairs and taxes to the same
category will give me an overall view of the cost of my vehicle.
If you have more than one vehicle, you should create another category named
Automobile 2 or Truck or something meaningful with the same subcategories.
You can set your preferences to use Imperial units or metric units. Preferences is
the only choice in the Edit menu.
HomeBank has a budget feature as well. You have a configuration window where
you can designate an estimate of your annual spending in each category. On the
left is a category list and at right you see blanks to fill in with an estimate of your
monthly expense. You have to designate spending for each category.
You can do it two ways. First, if you pay the same amount each month (like a
cable bill or rent or car payment), you can click in the radio button that says
(Budget for each month) is the same, then enter that amount in the box.

Second, for the categories that have occasional payments (my
auto insurance is paid twice a year), choose the radio button
before is different and fill in the months that apply. That method

Linux Financial Apps: HomeBank
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can also be used with categories where the payment varies, like natural gas,
which we use more in the winter. The categories that have already been
completed are displayed in bold text in the list on the left.
Just as it shows in the image above, your expenses must have the minus sign in
front of them to mark them as expenses. You have to type it in yourself. Make
sure you complete your salary category so you also have an income in your
budget. When you finish, you will have a table like the one shown below.

You can sort by category or subcategory, can list Income and Expenses or only
Expenses or only Income and can choose a certain time frame, like the present
year or the current month using the drop menus at left. Your budget can also be
shown as a bar graph. The term ‘Decay’ is the difference between the budgeted
amount and what has been entered in your accounts.

I think once you get used to some of the idiosyncrasies of HomeBank, it is a very
useful program. It works very well, but some of the columns are too close
together for me. I can widen most of them, but the next time I open the window
they haven’t stayed where I’ve put them, and are jammed together again. It
doesn’t affect the program operation, but I do find it a little bit annoying. I haven’t
found anything in the program about online banking. However, for someone who
is interested in keeping track of their budget, it’s a good program.

Linux Financial Apps: HomeBank
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Posted by ferry_th, February 8, 2012, running Openbox.



27

by Ralf Vöpel (DAGAZ)

Firefox and the Internet. The final Frontier. These are voyages of a PCLinuxOS
user. His never ending mission: to explore the strange WWW, to seek out new
Websites, to boldly surf where no man has clicked before … and ends up where
he did not want to.
Has it ever happened to you? You’re Google’ing for something and end up on an
adult or @#$#% website? Now, what if this happens to your kids and you are not
there? It is time to put a leash on the Fox. Thanks to Firefox’s Addons, we can
protect our kids from the big, bad WWW.
First, open Firefox, click on Tools, then Addons, and type Procon Latte into the
search box.

Hit Enter and you should get a few results:

We want to install ProCon Latte Content Filter 3.3. Click the Install button. You
will now be prompted to accept the EULA. This is the shortest EULA I have ever
seen in my entire PC hacking life.

Click on Accept and Install. Firefox will now download the Addon. When done,
the entry of ProCon Latte will change:

Firefox will install the selected Addon after a restart. Let’s click on Restart now
and wait for the Fox to come back to life. The first thing you will notice is that the
ProCon Latte entry is missing.
That is because Firefox has installed the Addon and it is now a so called
Extension. Click on Extensions and there it is.

Access Denied: Procon Latte Content BlockerAccess Denied: Procon Latte Content Blocker
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The Content Filter is now installed and ready for duty. Notice the three new
buttons: Preferences (customizing ProCon), Disable (turn ProCon off/on) and
Remove (uninstall the extension).
I do not think we have to go into detail for the Disable and Remove buttons.
However, Preferences is a different story. Let the customization begin.

Preferences:

Identify yourself!
The first thing we should do is to protect our Addon from ‘outsiders’. Click on Set
Password, enter a password, click OK and reenter the password.

If the passwords match....

….and the Set Password button changes to Remove Password.

Under General, everything is checked except the List Subscriptions > Enable
Subscriptions. Click to check that box, too. We‘ll look at that a bit later.

Access Denied: Procon Latte Content Filter
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The Blacklist:
This list holds a part of a website address. For example: www.your_kid_does
_not_need_to_see_this.com, the list would show: your_kid_does_not_need_to
_see_this.

A few common words that appear in websitenames are already in the list. You
can add your own website addresses without the ‘www’ and ‘com’, ‘net’, ‘org’ etc.
Add words and phrases to the list simply by clicking inside the list, watch where
the cursor starts to blink and start typing. If you put two words in one line then
BOTH words must match for the site to be blocked!

Blocked Words:
If a website passes the Blocked Sites list, ProCon Latte checks the text/contents
of the site. If one of the words or combinations are found, the site will be blocked.
How do I know which sites will be blocked, you ask? Well, let’s click the
Advanced Tab.

Advanced...

Limit Internet access to the Whitelist....
If checked ONLY, websites in this list (see Whitelist) can be pulled up. In other
words, if you have www.pclinuxos.com in the whitelist and you want to go to

Access Denied: Procon Latte Content Filter
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www.pclinuxos.de, you are not getting there. To get to both sites, add
pclinuxos.* to the whitelist and you are good to go.
Pro Whitelist: Only sites you want your kids to see can be pulled up.
Con Whitelist: Only sites you want your kids to see can be pulled up by you,
which means YOU can go nowhere else either. I leave this unchecked and
exercise more caution of the Blocked Sites and Blocked Words.

Render Websites only after....
Not recommended because adult content may flash on the screen before ProCon
catches the xrated content. However, if checked, pages load faster.

Explain why a site....

If Explain why... is checked, you get a message under your addressbar telling
you why the page was blocked. The bad thing about it is, you also get the
Options button. This allows your kid or any other user to allow the page to load,
even if the page is blacklisted. Even worse, he/she can add it to the whitelist.
Having this one checked would be the same as carrying water to the river. It
makes no sense. Recommendation: do not check that one.

Show custom warning....
Same as the Explain why.... setting, except you can type your own message
that would show up. You also get the Options button with your custom warning.
Again: do not check that one, either.

Now comes my favorite part of ProCon Latte, Redirect blocked Sites.

I made a single html page with LibreOffice Writer named accessdenied.html,
saved it in /home/dagaz/Documents/access_denied/. The picture is also located
in that folder. You can get the pic here: http://accessdenied.phpnet.us/access
denied_jpg_25.html or google for ‘access denied pictures.’
Whenever ProCon Latte blocks a page, Firefox opens the file accessdenied.html.
This is what it looks like in the browser:

Access Denied: Procon Latte Content Filter

http://accessdenied.phpnet.us/access-denied_jpg_25.html
http://accessdenied.phpnet.us/access-denied_jpg_25.html
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Simple, easy, cool.

Blocked Words
Some, well, most websites use the meta tag to describe the contents of their site
and other stuff. I leave this on.

Whitelist...
Here you can add all the pages you want to bypass the content blocker.
Remember, it only works if you click on Limit Internet access to Whitelist in the
Advanced Tab under Blacklist!

Profanity List
Let’s say you do not want to block anything at all, BUT, you do not want curse
words, bad or foul language to show up on the screen. This is the place.
Whenever ProCon Latte finds a word on the website matching the word in the
list, it is replaced by...hold onto your hats... the phrase or word you choose. In the
example every bad word would be replaced with !@#$%^&*

Subscriptions

The first time you click on it, ProCon Latte tells you that your subscription is
outdated. Just click on the Update Subscription button and the update will be
done free of charge.
Three more buttons left, Donate!, Settings and Close. (Wonder what that button
does? Once you click Donate!, (that is, if you want to), a new tab opens up and
connects you to Paypal.
Settings allows you to save (Export) your settings or restore (Import) your
settings. It is handy if you want to sync two or more PCs. Here, you can also
Restore ProCon Latte to Default. You will lose all your settings, of course. Make
sure you saved (Export) your settings.
Sure, there are more web content filters out there. However, this one is easy to
install, free, customizable and works with any OS that can handle Firefox. The
BIG negative part of ProCon Latte is it is a Firefox Extension. If you have a
different browser installed, then all the blocked sites, blocked words and profanity
lists are bypassed. If you want to use this one to protect your kids, make sure
nothing else but Firefox can boldly surf where no man has clicked before.
Here is the HTML code for the Access denied homemade page:
<!DOCTYPE HTML PUBLIC "//W3C//DTD HTML 4.0 Transitional//EN">
<HTML>
<HEAD>
<TITLE>* Access Denied *</TITLE>

<META HTTPEQUIV="CONTENTTYPE" CONTENT="text/html; charset=utf
8">

<TITLE></TITLE>
<META NAME="GENERATOR" CONTENT="LibreOffice 3.4 (Linux)">
<META NAME="CREATED" CONTENT="20120207;18244300">
<META NAME="CHANGED" CONTENT="20120207;18291000">
<STYLE TYPE="text/css">

Access Denied: Procon Latte Content Filter
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<!
@page { size: landscape }

>
</STYLE>

</HEAD>
<BODY LANG="enUS" BGCOLOR="#000000"
DIR="LTR">
<P ALIGN=CENTER><BR><BR>
</P>
<P ALIGN=CENTER><BR><BR>
</P>
<P ALIGN=CENTER><IMG
SRC="../path_to_where_the_picture_is_located/acc
essdenied_25.jpg" NAME="Access denied"
ALIGN=BOTTOM WIDTH=530 HEIGHT=675
BORDER=0></P>
</BODY>
</HTML>

Screenshot ShowcaseScreenshot Showcase

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!
Posted by GermanTux, February 1, 2012, running Xfce.

Access Denied: Procon Latte Content Filter
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by Meemaw

Sometimes you just want a simple little notetaking
program, or maybe just a sticky note to remind you
of things you have to do. Gnome has a couple of
handy little programs just for those types of tasks.

GNote, according to the Gnome Live Wiki, is the
same notetaking application as Tomboy. When you
start GNote for the first time, you get the window
shown below, which introduces you to the program.

GNote will put an icon in your system tray, and if you
wish, that’s all you will see. Left clicking on the icon
(yellow square in lower right corner) will pop up a
menu with your existing notes and the option to
create a new note. If you open a new or existing

note, it can stay on your desktop as long as you
wish.

If you choose ‘Create New Note’, a window will pop
up labeled ‘New Note #’ The # designates a number,
which corresponds to the number of notes you have
created. (For me, this was New Note 6.) You should
highlight that title and change it to something more
meaningful. From the window above, you see the
titles of my notes. Nothing complicated, but
meaningful to me.

These can evolve into an outline of sorts. Your main
note has a list of items in it, and each item can be
‘linked’ to its own note. In my job, I do a newsletter
which contains many articles about recent
happenings or coming events. In the note below, I
have listed many items that may be in the upcoming
newsletter. By highlighting one of the items, and
clicking on the second tool in the toolbar (the arrow
which circles around and points to a dot), you can
link the item to a new note with that item as the title.

In the new note I can write the article, list the major
points or even link that note to another one.

Another feature of GNotes is that you can place your
notes into Notebooks to organize them even more. I
have two notebooks so far: Meemaws and Work. All
the notes from my job are in the Work notebook, and
the magazine notes are in the Meemaws notebook.
From the menu, you can create a new note by itself,
or you can choose to create a note inside a specific
notebook. Those choices are at the bottom of the
menu.

Gnome 2.32: GNote & GlistaGnome 2.32: GNote & Glista

http://live.gnome.org/Gnote
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The toolbar on each note has a couple of handy
items. The button that looks like a paper with an
a,b,c on it is the text properties button. You can
format your text using this button.

The next tool (gear) is the note tools button. You can
export the note in html, print the note or see what
note(s) are linked to it. There are a few other tools
you can get, but these are the program defaults.

The red X is, of course, to delete your note. Make
sure you really want to delete it! The last icon
(looking like a notebook) is to insert the current open
note into the notebook of your choice.
Program preferences are available when you right
click the GNote icon in your tray. To close GNote,
the rightclick menu also has the choice "Quit”
Glista is a simple todo list program. According to
the Glista website, it is written in Gtk+ so it
integrates well with the Gnome desktop.
Glista also puts an icon in your system tray when
you start it. But when you leftclick it, you get a
single window. You can enter the subject for your list
in the line at the bottom, then click the plus sign to
the right.

You will now see the subject at the top of the
window. If you have more than one subject for a list,
they will be arranged in alphabetical order.

Notice in the list, two of the subjects have a little
clipboard icon to the right. This means that items
have been added to the lists. As soon as I added
items to the Grocery List, the clipboard appeared
there, too. If you doubleclick the title of the list, you
can change the title. If you doubleclick the
clipboard, the list appears in the bottom of the
window. In addition, singleclicking the clipboard at
the top will open the list at the bottom for whatever
task you have chosen (next page, top).

When you complete the task list, simply click the box
at the right of the clipboard. That is Glista’s
indication that the task is complete and Glista puts a
line through the task title (next page, bottom).

When you need to clean up this window, simply click
the “Clear Done Items” button, which looks like a box
with the left side pointed, containing a white X. All
your completed tasks will be removed. To remove a

Gnome 2.32: GNote and Glista

http://arr.gr/glista/
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single task, even if you haven’t marked it as
completed, choose it and click the red X. To close
the program, rightclick the panel icon and choose
Quit.

These two programs are small, but very useful.

Gnome 2.32: GNote and Glista

Screenshot ShowcaseScreenshot Showcase
Answers to Mark Szorady's Double Take:
(1) Hair different; (2) Cloud moved; (3) Arm shorter; (4) Hand missing from chair back;
(5) Shirt stripe different; (6) Footstool lower; (7) Word balloon different

Posted by DarkEra, February 26, 2012, running Xfce.
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ms_meme's Nook: PCLOS Trailms_meme's Nook: PCLOS Trail

Texstar comes to paint his OS nightly
So our desktop will shine brightly

Along the PCLOS Trail
Bits and Bytes scattered all along the Linux Way

Oh what a beautiful display
Along the PCLOS Trail

Open Source it always will prevail
We tried the others but to no avail

We're glad we found it and the forum that's around it
Fine friends that surround it

Along the PCLOS Trail

http://pclosmag.com/html/Issues/201203/files/alongthepclostrail.mp3
http://pclosmag.com/html/Issues/201203/files/alongthepclostrail.ogg
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by Darrel Johnston (djohnston)
The Live USB script was recently updated and now
includes more options. Thank you, Just18. Note that
the Live USB script can be run from an installation
on hard drive, or from a live CD session. The
following is a short tutorial.
The USB external drive or thumb drive should
already be partitioned and formatted before starting.
The Live USB script will not do it for you. You can
use ext2, ext3 or ext4 for the filesystem. FAT
filesystems are not supported. Start from the main
menu > More Applications > Configuration >
PCLinuxOS Live USB Creator. Be sure the USB
device you want to write to is not plugged in.

This window will
appear. Be sure it
shows version 0.9.7.
Then click OK.

The script must be
run as root. If you
select No, the script
will terminate. Select
Yes.

You will be prompted to enter root's password. After
entering it, click OK.

Be sure the USB drive you want to write to is not
plugged in. Answer Yes if the device is not plugged

in. If the device is already plugged in, safely remove
it, wait 20 seconds, then click Yes.
Plug in the USB device you want to write to, then
click YES.

A removable device automounter window may
appear on your desktop as soon as the USB device
is plugged in. If it does, do not open the file manager
to view the contents of the USB. Select Cancel. Do
not attempt to access the contents of the USB while
the Live USB Creator is running. I clicked Cancel
here.

PCLinuxOS Live USB Creator 0.9.7PCLinuxOS Live USB Creator 0.9.7
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Highlight the USB partition you want to write to, then
click OK.

If your USB device is empty, select Create a new
Live OS. If you are adding a second OS to the USB
drive, select the second option. Click OK.

If you are running this from an OS installed on the
hard drive, select Use an ISO file. If you are running

this from a live CD, select Use the files from a Live
Media. Click OK.

Highlight the boot menu name you want for this iso.
Click OK.

Select the iso file to use from the directories on your
hard drive. If you are installing from a live CD, you

will be prompted for the sqfs file to use.

The Live USB creation process will begin. Do not
interrupt it.

Standard live boot option will be the only one
checked by default. You can select as many
additional options as you want to be included in the
GRUB boot menu. If you want the option to save any
changes made to the USB drive, select Boot with

PCLinuxOS Live USB Creator 0.9.7
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Persistence. Note that Memory Test will appear in
the GRUB boot menu if selected, but it will not work
unless you have the memtest86 package installed
on your hard drive. If running from a live CD, you
can install memtest86 to memory from Synaptic.

If this is the first installation to the USB drive, select
Install Grub to the MBR. If you are managing your
own bootloader, select one of the other two options,
depending on your preference.

Congratulations. You have completed the
installation. Before you do anything else, remove the
USB drive you just wrote to. Then click the OK
button.

Here are the files that were installed to the USB.

If more ISOs are installed to the USB using this
script, each one will have a separately named sqfs
loop image file, and a separately named folder for
saving persistent changes.

PCLinuxOS Live USB Creator 0.9.7

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
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4. No representations, warranties or guarantees whatsoever are
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by Paul Arnote (parnote)

It’s late at night. You’re wanting to fill up your MP3
player with songs for your vacation. You have all of
your favorite music on CDs that you have
purchased, but don’t want to take the time to rip
those CDs to MP3 files. Instead, you opt to
download that very same music that you purchased
on CDs as MP3 files, via torrent files.
Does that scenario sound familiar? Of course,
torrent files aren’t just for downloading music or
video files. Torrent downloads can also include
entire operating systems, such as PCLinuxOS. In
fact, that’s one of the distribution methods utilized by
PCLinuxOS to get the operating system into the
hands of users.
Unfortunately, there has been an international crack
down on torrent tracker sites by the “copyright
gestapo,” more commonly known as the MPAA and
RIAA, in cahoots with their paidoff politicians. It has
resulted in more than one torrent site closing down,
out of fear of being caught up in the witch hunt for
those committing copyright infringement. Still, there
are torrent sites who refuse to be bullied about, and
who refuse to shut down. Instead, they’ve switched
to using what has become known as “magnet links.”

The “traditional” torrent file method
Traditionally, you download a .torrent file (also
known as a torrent tracker) to your computer from a
torrent site. This is a smaller file, containing

information about the larger file you want to
download. This information includes a list of the files
being shared, the URL for those files, and other
pertinent information. Your torrent client (Deluge,
Transmission, Ktorrent, etc.) calculates a hash code
for that particular torrent. The torrent server then
uses that hash code to find others who are
uploading those files, so you can download from
them.

There are quite a few torrent clients in the
PCLinuxOS repository. Here is a list of most of them.
I’m only listing those that are more commonly used
for downloading torrents.
1. BitTorrent (unknown)
2. Deluge (Gtk+/Gnome)
3. FatRat (Qt4)
4. Gnome BTDownload (Gtk+/Gnome)
5. Ktorrent (KDE/Qt4)
6. qBittorrent (Qt4)

7. rTorrent (command line)
8. Transmission (Gtk+)
9. Vuze (Java)
With the traditional approach, using torrent trackers
downloaded from a central torrent server, users are
much more likely to receive a DMCA (Digital
Millennium Copyright Act) take down notice,
according to a 2008 University of Washington
Department of Computer Science & Engineering
study. The copyright gestapo are more likely to link
your IP address with the torrent tracker file that was
downloaded, resulting in a ceaseanddesist order
coming from your ISP or the MPAA or RIAA
themselves – regardless of whether you completed
the torrent download or not.

What are “magnet links?”
Magnet links skip the “middle man,” with the hash
values being calculated on the server end (instead
of by the torrent client) and are sent to the torrent
client. The torrent client then uses the hash value to
seek out the addresses of peers on the network,
connects to them, downloads the .torrent file, then
the desired content. In this way, no torrent tracker
files are stored at any central repository, such as
PirateBay or bitsnoop, making it much, much more
difficult for your torrent activity to be tracked – and
decreasing the likelihood that you’ll be receiving one
of those aforementioned ceaseanddesist orders.
Here is what a couple of magnet links look like:

Five of the torrent clients in the PCLinuxOS repository.

Magnet Links: The New BitTorrent ApproachMagnet Links: The New BitTorrent Approach

http://torrentfreak.com/study-reveals-reckless-anti-piracy-antics-080605/
http://thepiratebay.se
http://bitsnoop.com/
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magnet:?xt=urn:btih:768435fee54cf3c072c36f5ede02289509e49386&dn=Dream+House+2011+720p+BDRip+x264+ac3+subs+%28mkv%29+%5BGREYSHADOW%5D&tr=udp%3A%2F%2Ftracker.openbittorrent.com%3A80&tr=udp%3A%2F%2Ftracker.publicbt.com%3A80&tr=udp%3A%2F%2Ftracker.ccc.de%3A80
magnet:?xt=urn:btih:X77SNTKZAWN3EQZSNKB7KRS7TNTZ3YSH&tr=http://tracker.mininova.org/announce
The original specification came out for magnet links
in January 2008, and called for base32 encoding.
Then, in May 2008, the specification was changed in
favor of hexadecimal encoding. The first magnet link
listed above, from PirateBay, uses hexadecimal
encoding. Other sites, like mininova, use the original
base32 encoding, as shown in the second magnet
link. Your torrent client should not balk at either, and
will accept both without hesitation. This includes all
of the torrent clients currently in the PCLinuxOS
repository.
Does this mean that torrent tracker files have gone
away? Not at all, and probably not any time soon.
But, the move is more and more towards the use of
the magnet links. In the screen capture below, there

are two download links (in green). The first one,
labeled “Get This Torrent” with the magnet next to it,
is (you guessed it!) the magnet link. The second
one, labeled “Get Torrent File” and with the double
green arrows next to it, is the traditional torrent
tracker file.

Adding support to your web browser
Neither Firefox nor Chromium Browser know how to
handle magnet links. So, we have to teach them
what to do with them. The method below depends
on gconftool2 being installed. As far as I can tell, it
comes as part of the base installation of
PCLinuxOS, without regard to the desktop
environment being used.
Enter the following three lines in a terminal session
(each on a single line):
gconftool2 t string s/desktop/gnome/urlhandlers/magnet/command"transmission %s"
gconftool2 s /desktop/gnome/urlhandlers/magnet/needs_terminal false tbool
gconftool2 t bool s /desktop/gnome/urlhandlers/magnet/enabled true
In the first line, substitute transmission (inside the
quotes at the end) with the name of the torrent client
you are using. These commands register magnet
links with xdgopen to open them with your chosen
torrent client.

Now, when you click on a magnet link in Chromium
Browser, the magnet link will open in your chosen
torrent client. When you click on a magnet link in
Firefox, you will be given the choice to choose the
application to use. Select your torrent client (the one
you used in the above commands should be listed).
Be sure to mark the check box at the bottom of the
dialog box for Firefox to “remember” what to do with
magnet links in the future before you click on the OK
button.
To be honest, I was surprised that magnet links
worked without further modification in Firefox.
Everything I found on the Internet pointed to having
to go into about:config and changing some settings
there. In fact, I was prepared to write a whole
separate section on how to get Firefox to recognize
magnet links when I decided to first give them a try,
having made the entries above for Chromium
Browser. But as it turns out, Firefox also picks up on
what to do with magnet links, using the method
above.

Summary
Try as hard as they may, the MPAA, RIAA and the
misinformed, misdirected politicians will not succeed
in making file sharing disappear. Instead, they will
force it deeper and deeper underground. Developers
will devise ways to hide and otherwise obscure file
sharing activities.
I must say that I’m not condoning copyright
infringement. However, when I purchased the same
music on vinyl records, then audio CDs, theA partial screen capture from PirateBay.

Magnet Links: The New BitTorrent Approach

http://www.mininova.org/
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copyright holder got double their pound of flesh from
me. Just because the primary and preferred format
for music distribution changes, it shouldn’t mean that
the copyright holder should be able to extract yet
another pound of flesh – all over nothing more than
a distribution format change. I paid the price – twice
in many cases – for the rights to listen to that
copyrighted content. In my honest opinion, the same
holds true for other media (videos) whose primary
distribution format changes, but the content remains
the same.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by JohnW_57, February 13, 2012, running KDE4.

Magnet Links: The New BitTorrent Approach

http://www.pclinuxos.com/?page_id=10
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by Ramchu

I have this friend of 30 years. He is a car enthusiast,
and not computer literate at all. As we visited from
time to time over the past year, occasionally the
subject of computers would come up and I would
mention that I don't use Windows on my computers.
I explained that, instead, I run an operating system
known as PCLinuxOS with the desktop environment
KDE, and explain how trouble free it is, what with not
having to run an antivirus program and not having
to deal with the automatic updates that Windows
has.
About a month ago, I was at his place and was
telling him that I had come across what I thought
was a really good price on a new Lenovo Desktop
computer. I mentioned that I was going to purchase
it for my wife, since her computer is 7 or 8 years old
and needs to be updated.
He says that he would go to the computer shop with
me to pick it up. We get there, and to my surprise,
he buys one just like the one that I had just
purchased for my wife.
We go back to his place and he can't wait to get his
new computer hooked up. So, I hook it up and get it
up and running. It came with Windows 7 Home
Premium preinstalled.
To my surprise, the next thing that he wants to know
is, when can you put this Linux thing on my
computer. I told him that it would take me about an
hour if he or his wife had a blank CD.

I downloaded the latest PCLinuxOS iso (2011.9 kde
full version). I then downloaded EaseUS partition
Master (free for home users) from easeus.com, and
installed it on his new computer. I then reduced his
Win7 partition from 500 gig down to 250 gig. After
that process completed, I downloaded InfraRecorder
CD/DVD burning software and burned the

PCLinuxOS ISO image to a CD. Next, I booted into
the BIOS, set the Boot order to boot from the CD
ROM drive, and booted to the PCLinuxOS Live CD. I
then installed PCLinuxOS onto the Hard Drive,
rebooted the computer, opened Synaptic, and
downloaded and installed all the available updates.
At this point, his wife is telling me that I am going to
regret doing this, since she is the one that has been
having to maintain his computer, doing all of the

software installs,updates, defragmenting, virus
scans, malware removal, ect., since he refuses to
learn anything about computers.
She is saying that I have just created myself a
monster, and he will be calling me at all hours of the
day and night, along with having me to come over to
fix his computer all of the time. I explain to her not to
worry because I installed PCLinuxOS onto my in
laws computer (they are in their 70's with no
computer background at all) and are doing just fine
with it surfing the web, sending and receiving email
and watching videos.
At the time of writing this, it has been 4 or 5 weeks
now and I have had only 1 phone call from my friend
with a question about his computer. He was asking
how to stop all of the advertising in his FireFox web
browser, and I was able to walk him through adding
AdBlock Plus to Firefox over the phone.
His wife is also amazed that he is not consistently
complaining that this don't work, or that is broke, and
she now only has her Windows XP to deal with.
Just one more satisfied PCLinuxOS convert.

Testimonial: My Second PCLinuxOS ConvertTestimonial: My Second PCLinuxOS Convert

http://pclinuxos.com/?page_id=7
http://www.oneclicklinux.com
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ms_meme' Nook: Rollin' With PCLOSms_meme' Nook: Rollin' With PCLOS

PCLinuxOS

Rollin' rollin' rollin' through the net we're strollin'
Keep that bull a rollin' rawhide
Through rain wind and weather PCLOS is always better
I'm glad Texstar is by my side
You don't know what you're missing
All others start dismissing
It's the best OS I have tried
Boot 'em up Root 'em up Root 'em up Boot 'em up
Boot 'em up Root 'em up in stride
Boot 'em up Root 'em up Root 'em up Boot 'em up
Boot 'em up Root 'em up with pride
Keep movin' movin' movin' PCLOS we're approving
Keep that bull a movin' rawhide
Download the ISO all others you will forego
Our distro is known far and wide
My heart's palpitatin' my forum friends are a waitin'
In the Sandbox they all reside

http://pclosmag.com/html/Issues/201203/files/rollingwithpclos.mp3
http://pclosmag.com/html/Issues/201203/files/rollingwithpclos.ogg
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by Darrel Johnston (djohnston)
There are two extremely powerful and innovative
creations of the Solaris operating system. The first of
these is DTrace, which is a dynamic instrumentation
framework. The main components of the system are
the DTrace framework and the instrumentation
providers, both residing in the kernel. The main idea
behind separating the two subcomponents resides
in the fact that different providers can have different
instrumentation techniques. Instrumentation
providers are loadable kernel modules that define a
set of probes they can activate on demand. These
probes are advertised to system users and can be
identified by the following four criteria: <provider
name, module, function, probe name>. System
users can specify in a script file the four elements to
activate a specific probe, or any subset of the four
elements to activate all the probes that match the
specified subset.
The D language, used for Dtrace scripting, is derived
from a large subset of C, and allows access to the
kernel's native types and global variables. Users can
specify inside the D script file the providers' names,
the probes' names, and the actions to take
whenever each probe is hit. This file can then be
compiled by the D compiler implemented in the
DTrace library and invoked by the DTrace
command. Upon execution, the DTrace framework
enables the probes that were specified in the file by
making appropriate calls to the probe's providers.
There are many features inherent in the framework
that make systems administrators' and
programmers' debugging tasks much easier.
Examples of the D language and Dtrace's
capabilities are way beyond the scope of this article.

The DtraceToolkit, which is a collection of over 200
useful and documented DTrace scripts developed by
Brendan Gregg, can be downloaded from the
OpenSolaris.org's website, which now has Oracle
branding.
Like any good system administrator, I checked for
any updates at the beginning of my last
OpenIndiana session. There were a few. Eight
hundred and sixty five, to be precise.

I wasn't sure why there were so many, until the
downloaded packages had been installed and this
dialog
window
popped up.
A new boot
environment
had been
created and
I was asked
whether to

reboot now or later. I chose now. After reboot, there
was a new GRUB entry, selected by default.

After logging into the Gnome session, I saw no
apparent changes. Let's see what they were, apart
from all those packages. Before the update, uname
a showed SunOS openindiana 5.11 oi_151a i86pc
i386 i86pc Solaris. After the update, it showed
SunOS openindiana 5.11 oi_151a2 i86pc i386 i86pc
Solaris . That's a kernel upgrade from alpha version
1 to alpha version 2, although the new boot
environment is named openindiana1. It was done
on the running OS, updated in place, with only a few
mouse clicks and supplying the root user's
password. It sure beats upgrading a BSD kernel and
userspace.
The second extremely powerful and innovative
creation of the Solaris operating system is the ZFS
file system. ZFS is a new kind of file system that
provides simple administration, transactional
semantics, endtoend data integrity, and immense
scalability. It is a fundamentally new approach to
data management.
ZFS presents a pooled storage model that
completely eliminates the concept of volumes and
the associated problems of partitions, provisioning,
wasted bandwidth and stranded storage. Thousands

Alternate OS: OpenIndiana, Part 2Alternate OS: OpenIndiana, Part 2

http://hub.opensolaris.org/bin/view/Community+Group+dtrace/dtracetoolkit
http://bdgregg.blogspot.com/
http://hub.opensolaris.org/bin/view/Main/
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of file systems can draw from a common storage
pool with each one consuming only as much space
as it actually needs. The combined I/O bandwidth of
all devices in the pool is available to all file systems
at all times.
All operations are copyonwrite transactions, so the
ondisk state is always valid. Every block is
checksummed to prevent silent data corruption, and
the data is selfhealing in replicated (mirrored or
RAID) configurations. If one copy is damaged, ZFS
detects it and uses another copy to repair it.
ZFS introduces a new data replication model called
RAIDZ. It is similar to RAID5 but uses variable
stripe width to eliminate the RAID5 write hole (stripe
corruption due to loss of power between data and
parity updates). All RAIDZ writes are fullstripe
writes. There's no readmodifywrite tax, no write
hole, and no need for NVRAM in hardware.
Disks can fail, so ZFS provides disk scrubbing.
Similar to ECC memory scrubbing, all data is read to
detect latent errors while they're still correctable. A
scrub traverses the entire storage pool to read every
data block, validates it against its 256bit checksum,
and repairs it if necessary. All this happens while the
storage pool is live and in use.
ZFS has a pipelined I/O engine, similar in concept to
CPU pipelines. The pipeline operates on I/O
dependency graphs and provides scoreboarding,
priority, deadline scheduling, outoforder issue and
I/O aggregation. I/O loads that bring other file
systems to their knees are handled with ease by the
ZFS I/O pipeline.

ZFS provides 2 64 constanttime snapshots and
clones. A snapshot is a readonly pointintime copy
of a file system, while a clone is a writable copy of a
snapshot. Clones provide an extremely space
efficient way to store many copies of mostlyshared
data such as workspaces, software installations, and
diskless clients.
You snapshot a ZFS file system, but you can also
create incremental snapshots. Incremental
snapshots are so efficient that they can be used for
remote replication, such as transmitting an
incremental update every 10 seconds.
There are no arbitrary limits in ZFS. You can have
as many files as you want: full 64bit file offsets,
unlimited links, directory entries, and so on.
ZFS provides builtin compression. In addition to
reducing space usage by 23x, compression also
reduces the amount of I/O by 23x. For this reason,
enabling compression actually makes some
workloads go faster.
In addition to file systems, ZFS storage pools can
provide volumes for applications that need raw
device semantics. ZFS volumes can be used as
swap devices, for example. And if you enable
compression on a swap volume, you now have
compressed virtual memory.
The constanttime snapshots are easily set up in
OpenIndiana by using the time slider manager
system utility. In the Gnome menu, go to System >
Administration > Time Slider. After supplying root's
password, you will see the Time Slider Manager
window as shown above, at right.

Check the Enable Time Slider box to start the
service. But, wait! There's more. Click Advanced
Options.

Backups can be stored on an external drive. You
can selectively choose the mount points to back up.

Alternate OS: OpenIndiana, Part 2

http://blogs.sun.com/roller/page/bill?entry=zfs_vs_the_benchmark
http://blogs.sun.com/roller/page/bill?entry=zfs_vs_the_benchmark
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Note that the new /rpool/ROOT/openindiana1 boot
environment can be individually selected to exclude
the older boot environment. The File Systems To
Back Up choice is set to All by default. That's the
one I chose. Once the OK button is clicked, a
current system snapshot will be saved.

Once the time slider has been activated and is in
use, the snapshot history icon in the Nautilus file
manager is available for use.

Just as a quick test and demonstration, I moved the
~/wallpaper folder to ~/Documents/wallpaper (top,
center).
Then I selected the previous system snapshot in the
file browser by clicking the vertical button to the left
of the Now black diamond (center, bottom).

Voilà. The wallpaper folder is back in my home
directory. We can attach a second SATA hard drive
and add mirror capabilities by using a series of
pfexec commands to replicate the first drive to the
second one. Or, we can use the time slider GUI to

use the second drive for ZFS snapshots. For more
guidance on using ZFS, consult the Oracle Solaris
ZFS Administration Guide.
Although the Mozilla applications are dated, (Firefox
is version 3.6.12 and Thunderbird is version 3.1.4),
and the choice of office applications is slim, I find
OpenIndiana a pleasure to use. With the familiar
Gnome 2.30.2 desktop environment, the very
Synapticlike package manager GUI and the
included system tools, it feels much like a Linux
system. That is, until you consider the “back in time”
capabilities of ZFS and Time Slider and the
advanced troubleshooting capabilities of DTrace.
This OS is running with only 1GB of system RAM
and a 20GB hard drive. df / shows only 19% of
openindiana1's rpool in use. And, although the
previous and current OpenIndiana versions are both
listed as alpha releases, the OS is extremely stable,
if not yet feature complete. I experienced no mouse,
keyboard or window drawing lag times whatsoever.
None of the applications ever crashed. And with
ZFS, file system checks are, hopefully, a thing of the
past.

Alternate OS: OpenIndiana, Part 2

http://www.pclinuxos.com
http://www.enkiconsulting.net/
http://docs.oracle.com/cd/E19253-01/819-5461/gitic/
http://docs.oracle.com/cd/E19253-01/819-5461/gitic/
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Top Left: Posted by la_monda, February 16, 2012, running LXDE. Top Right: Posted by parnote, February 17, 2012, running Xfce.
Bottom Left: Posted by Crow, February 6, 2012, running KDE4. Bottom Right: Posted by LKJ, February 5, 2012, running Openbox.

More Screenshot ShowcaseMore Screenshot Showcase






